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Opening

1. The Chair of the Operating Model Specification and Software Upgrade Workshop
(OM Coding WS), Dr. Ana Parma, opened the meeting and welcomed participants
(Attachment 1).

2. The draft agenda was discussed and amended, and the adopted agenda is shown in
Attachment 2.

3. The list of documents for the meeting is shown in Attachment 3.

Agenda Item 1. Introduction

4. The consultant for the OM coding project, Dr. Darcy Webber, reviewed the goals of
the project and presented a brief progress report. The introduction, as well as the
different agenda items were covered using five presentations which are included as
attachments 4 to 8.

Agenda Item 2. Overview of model code

5. Dr. Webber presented an overview of the model code structure (see Attachment 5)
including the series of R functions and the C++ code that evaluates the objective
function. In the latter, he explicitly retained ADMB code alongside the new TMB
code and this helped show the differences between the two languages. He guided
participants through the steps involved in connecting to the SBT Github repositories
where the new software is hosted.

6. At present, the sbt package is hosted in Dr. Webber private Github repository
because the assessment input data files are confidential, meaning that the repository
cannot be made public, but maintaining a private institutional Github repository that
uses Github actions (for building the website and running model checks) is costly.
Alternatively, the input data could be stored separately (in the CCSBT private site)
and the package could be made public.

7. Participants installed the new sbt R package developed under the project as well as
an sbt models suite of helper functions for running examples, plotting, and
analysis of model outputs. All participants were able to download, build, and execute
a stock assessment using the new sbt package and generate plots using
sbt models.

8. In general, the new TMB version of the assessment (i.e., sbt) code matched the
current ADMB version code except for obvious differences in syntax between the
programming languages. Certain computations related to fixed data and functions
were also moved outside the main C++ code into simpler R scripts for improved
efficiency and transparency. This included preprocessing of the data (i.e., as done in



the PRELIMNARY CALCS section of the ADMB code) and streamlining all the
data into simple ASCII files.

Dr. Webber presented comparisons between the ADMB and TMB implementations of
the sbt assessment model when each was provided the same input parameters and
data. Model predictions agreed to within acceptable levels of machine precision (e.g.,
1.e-8) for all outputs demonstrating that the population dynamics, likelihoods, and
inferred quantities were nearly exactly replicated in the new TMB software.

Agenda Item 3. Running models

10. Following the instructions provided in Attachment 6, participants installed all the

11.

12.

13.

current software and were able to build the package (“sbt”) and run the current
version of the model and data using scripts provided in “sbt_models”. This meant that
all the software worked seamlessly on Linux, MacOs, and Windows operating
systems.

Dr. Webber showed that the new model matched the existing model precisely. He
demonstrated a variety of features that simplified the data input and plotting and
diagnostic outputs.

He first ran a single operating model (OM) grid cell to demonstrate the workflow
used to generate an assessment result from raw data input (i.e., in .csv format),
converting to formats required by the st model, compiling the TMB code,
executing an assessment model fit, and plotting the resulting estimates.

Code examples were also provided to complete the above steps for the entire OM grid
(Attachment 6). This includes creating a grid, extracting outputs, plotting
inputs/outputs, and comparisons with the ADMB model.

Agenda Item 4. Bayesian inference

14.

15.

16.

17.

The new sbt package has substantially greater power to assess uncertainty in the
stock assessment via Bayesian methods. Dr. Webber presented an example Bayesian
implementation via the R tmbstan package applied to a single OM grid cell as well
as another example involving four OM grid cells (see Attachment 7).

This includes extracting and plotting MCMC outputs, MCMC diagnostics, reduced
grid structure for MCMC runs, comparison of OM uncertainty obtained via MCMC
(including within-cell uncertainty) vs standard grid, and model comparison using the
leave-one-out information criterion.

Dr. Webber also demonstrated how sbt implements the leave-one-out information

criterion (LOO IC) for assessing the relative credibility and possibly future weighting
of alternative operating models.

Overall, the group was enthusiastic about the potentially large improvements to future
sbt assessments made possible by the new sbt package and especially how much
progress was made in such short time. The group looks forward to seeing the next
phase of the sbt package in the June 2024 OMMP meeting.


https://github.com/CCSBT-Dev/sbt_models
https://github.com/CCSBT-Dev/sbt_models

Agenda Item 5. Next steps

18.

19.

20.

21.

22.

23.

The group discussed modifications (described below) to the assessment modelling
approach that could improve several aspects including computational efficiency, bias
reduction, and representation of uncertainty. Some of the proposed changes would be
developed over the next few years but would not be incorporated into the formal
stock assessment and operating model conditioning until after the next stock
assessment to be conducted in 2026.

Fisheries and selectivity—The group discussed alternative methods for incorporating
LL3 and LL4 fisheries into the assessment model. These fisheries each had short
periods of substantial catches in the distant past and several years of very small
catches and low-quality length-composition data more recently. Fitting the length
composition data for these fisheries requires estimating time-varying selectivity
involving hundreds of extra parameters in the assessment model even though there is
little information gained. In addition, these fisheries are not carried into the projection
code and so there is no need to estimate a selectivity for them. The proposal for future
model changes involved (i) converting the length compositions to age composition
via cohort slicing; (i1) subtracting the calculated catches-at-age from the SBT
abundance-at-age in each year; and (iii) removing the length compositions from the
model likelihood (fitting procedure). This approach would adequately account for
these fisheries’ removals while simplifying the model parameter estimation without
loss of information about SBT abundance.

Time-varying selectivity for remaining fisheries—the group discussed a new Gaussian
Markov Random Field (GMRF) approach to modelling time-varying selectivity for
LL1, LL2, Indonesian, and Australian fisheries. The GMRF approach would provide
a more formal statistical implementation of the current piece-wise time-varying
approach to fishery selectivity.

Length-/age-composition likelihoods—the group discussed alternative likelihood
formulations for composition data including the Dirichlet-multinomial to provide a
more objective self-weighting approach to fitting this data.

Australia presented paper OM Coding WS/2311/04, which described a possible
length-/age-structured approach to the next generation SBT assessment. As noted
above, such changes would be developed over several years and would not be
implemented in the next stock assessment cycle but could be available for the
following one. Even though a length-/age-based model would require adding a new
length dimension to the model, several computational processes within the model
would become more efficient, simpler, and probably more accurate since some
processes in the population and fishery dynamics are length-based. For example,
juvenile mortality, selectivity, reproductive output, and recapture of tagged
individuals are influenced by individual body length, but the current approach treats
these mainly as age-based or as functions of an overall mean length.

A joint length-/age-structured approach would improve the representation of parent
ages in the CKMR POP and HSP likelihoods. In particular, the current model
assumes that the age of a parent is known exactly based on its length even though an



24.

25.

26.

27.

SBT of a given length could be one of many possible ages. A length dimension would
accommodate this uncertainty as well as possibly reduce associated bias.

For future structural model changes that track length and age more completely, it will
be important to evaluate details on things like the number and size of length bins for
both computation and population-level applicability.

The group noted that a good practice to do a release as each assessment is completed
and adopt semantic version numbering system (e.g., https://semver.org). This should
also be used to lock the model and data for that assessment so it can be recovered in
the future. This may also include saving the computer environment that was used at
the time (e.g., using Dockers).

For future model configurations, the group discussed how the CPUE predictions from
the model should be treated based on length compositions that are weighted by
density rather than catch (as presently done). Furthermore, the size composition data
for the LL1 fleet includes size composition data corresponding to the catch from other
members (e.g., Korea, New Zealand, and Australia) which should be excluded for
CPUE predictions. This is because the CPUE data are based solely on the Japanese
fleet at present.

A number of issues encountered during the model recoding were considered by the
workshop and either resolved or assigned to participants for implementation of
needed code changes. The group discussed next steps and timeline proposals.

Ideally the following changes would be implemented before the June 2024 meeting so that they
can be evaluated by the OMMP working group:

a) Lump the LL3 and LL4 fisheries and cohort slice and treat as removals

b) Specify the LL1, LL2, Australian and, Indonesian selectivity using GMRF

c) Review this years sensitivities and robustness tests and make sure all the code to do
these is available

d) Can filter out some of the POPs in get data that result in likelihood values that are not
used in the estimation

¢) Name the grid runs in run_grid

f) Implement grid sampling in the R code

g) Re-code tag likelihoods to remove the H* parameters (harvest rate for mixing periods)
and add the output for the PSIS-LOO diagnostic

h) Implement the Dirichlet-multinomial likelihood for composition data

1) Code prior distributions in short-hand (following R format; e.g., dnorm())

j)  Incorporate the age-uncertainty for the adult part of the POP calculations (the possible
ages given length)

k) Update website to improve documentation (e.g., add vignette on “how to run the
grid”).

1)  Evaluate if other “Stan” R packages (e.g., adnuts) can be used to help evaluate model
runs.

Other tasks that could be completed at the June 2024 meeting include:

m) Review harvest rate function and determine if a penalty is required to keep it below
0.9 (currently there is no penalty in the sbt model)
n) Categorize what we want to add to REPORT and ADREPORT in the TMB code


https://semver.org/

0) Implement “one-step ahead residuals” diagnostics for judging fits to composition data
p) Evaluate how the grid should be modified in light of new MCMC capabilities

Tasks that could be done after the June 2024 meeting include:

q) Projection model developments: two options were discussed, an interim option that
requires the TMB code to output the same variables that the ADMB conditioning code
passes to the projection code, so that the old projection code can be run (with inputs in
the same format) or a final option where projections are implemented within the
“simulate” blocks of the TMB code.

r)  Add in the supplemental optimization code to compute MSY quantities by year using
year-specific parameters and catch allocations between fleets.

Work plan

28. In addition to the June 2024 meeting, the group discussed online workshops noting
that two 2-hour online meetings each year are part of the project. The group noted
that one webinar to be conducted during December this year would provide the
opportunity for OMMP members that did not attend to workshop to review this report
and provide feedback on direction and project status. A second meeting would be
prior to the June meeting and may be more technical in nature.
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Project specifications sbt

A (Start year): 2023

B (Duration): 3 years

C (General category): OM

D (Sub category): Asses

E (Project title): Operating model specification and software upgrade

| (Impact Scale): High

J (Impact timing): Med

K (Priority): to be completed at ESC meetings.
L (Rank): to be completed at ESC meetings.

** (budget source): CCSBT

Project specifications: problem definition sbt

F (Problem): The current operating model (OM) specifications, code, and software
present challenges for

1. communicating the population dynamics and statistical assumptions
underpinning the SBT model;

2. addressing uncertainty within the OM grid; and

3. revising and implementing alternative hypotheses in stocks assessments and
future MP evaluations.



Project specifications: objectives sbt

G (Objectives):

1. Update and revise OM documentation to match the OM code;
2. Develop new OM implementations in eitherStan-er Template Model Builder

(TMB) software;
3. Code modifications to the OM to be decided by the OMMP Working Group to

improve estimation efficiency and allow future flexibility in adding/removing
complexity and features as needed;

4, Complete validation test comparing estimates from new implementation with
current ADMB version.

Project specifications: rationale sbt

H (Rationale): Upgrading to modern software will improve the flexibility, utility, and
understanding of the SBT operating and assessment models for all CCSBT
participants. Improvements to model structural and statistical procedures will
potentially result in better presentation and understanding of historical, current and
future SBT stock status, its associated uncertainty, and MP performance.



Project specifications: resources

25d Consultant

20d Consultant

20d Consultant

2d MP Coordinator

2d MP Coordinator

2d MP Coordinator

1d extra at ESC meeting
(VEH, Cat, 3P, 1C, 1Ch, Sec)

1d extra at Seattle OMMP
meeting
(Cat, 3P, 1C, 1Ch)

3d dedicated inf. OMMP meeting
(Tokyo: FreeV, Cat, 3P,1C, 1Ch)

5d dedicated OMMP meeting
(Seattle: FreeV, Cat, 3P, 1C,
1Ch)

2*2hr online meetings
(3P.1C, 1Ch, Sec)

2*2hr online meetings
(3P.1C, 1Ch, Sec)

2*2hr online meetings
(3P,1C, 1Ch, Sec)

Project specifications: work plan 2023

SNOSNSN

progress.

(M

code:

Cleaning of old code and documentation.

Darcy works on new conditioning code to match old code.
One or more informal short (1-2 hour) online meetings.
One extra day added to the scheduled in-person OMMP meeting to discuss

1 compare conditioning results obtained with old and new code;
4 show structure and receive feedback;
3 discuss projection code (could run old projection code with outputs from new code as an

intermediate step);

3 prioritise work (changes to the code) for 2024

3 Provide training/tutorial

sbt

The abbreviations
used in are:
Sec=Secretariat
Staff,
Ch=Independent
ESC Chair,
P=Independent
Advisory Panel,
C=Consultant,
Cat=Catering
only, VEH=venue
& equipment hire
etc,,
FreeV=Venue &
some equipment
at no cost.

sbt

3-day in-person meeting in November focused on the transition to the new



Project specifications: work plan 2024 sbt

ad 5-day OMMP in person meeting in June to discuss/implement/evaluate changes
to the OM (conditioning and projections), and provide training/tutorial
O One extraday at ESC to discuss progress.

General introduction sbt
e The operating model (OM) has been coded in template model builder (TMB)
e | haveintegrated the modelinto an R package that | have named sbt
e TheR package is available online on GitHub
e TheR package / GitHub format has many symbiotic benefits including

o Readily available documentation
o Continuous integration (CI)

o Issue/bug tracking

o Easeofuse



Software requirements sbt

e The statistical programming language R
o Recommend an up-to-date version of R (| am using version 4.1.2)
o Recommend a graphical user interface (GUI) for R (e.g., RStudio)
e Rpackages
o TMB, RcppEigen, tmbstan, rlang
o tidyverse, reshape2, scales, ggridges
o rstan,loo
o parallel, doParallel, foreach, MASS
o knitr, kableExtra, rmarkdown, testthat
e GitHub
o Youwill need a GitHub account to access sbt as it is a private repository
o RStudio has GitHub access built in (see the "Git” tab)

GitHub sbt

The sbt R package is stored on GitHub: https:/github.com/quantifish/sbt

This is a private repository so you will need a GitHub account to be able to access
the repository. If you do not have access please let me know your username so | can
allow you access to the repository.

If you want to clone the repository to your computer then you can use something
like:

git clone https://github.com/quantifish/sbt



README.md

The README.md file is
generated using
README.Rmd.

It automatically displays
when you navigate to the
GitHub repository.

It contains some installation
instructions.

Installation

Also note the R-CMD-check
Passing badge (more later).

Option 1

The components of the R package include:

e data e DESCRIPTION
e data-raw e LICENSE

e docs e NAMESPACE
e man e NEWS.md

e pkgdown e pkgdownyml
e R e README.md
® src e README.RmMd
e tests e _gitignore

e vignettes e _Rbuildignore



R package: data and data-raw sbt
The sbt/data-raw directory contains:

e Twodirectories containing all of the input/output files for two model runs
(base22 and base22sqrt_trollpe)

e The sbt/data-raw/csv directory which contains “.csv” files with all of the input
data (e.g., aerial_survey.csv, catch.csv, cpue.csv, mean_length.csv,
tag_recaptures.csv)

e AnRscriptfor processing the raw data and saving to the sbt/data directory in

the compressed “rda” format:
o data_csvl.rds,data_labrepl.rda, and data_parl.rda
tag_recaptures.rda, tag_releases.rda, and tag_reporting.rda

R package: R sbt
The R directory contains all of the R functions that are included with the package.
Each function is documented using Roxygen so that when the package is built, the
help files (stored in the sbt/man directory) are updated automatically. For example:

-

Doxygen
help

R code /
function




R package: src sbt

The sbt/src directory contains the TMB model itself. The model code is split into two
files:

e sbt/src/sbt_v100.cpp
e sbt/src/functions.hpp

The sbt/src directory also contains makefiles for both Linux and Windows machines:

e sbt/src/Makefile
e sbt/src/Makefile.win

When the package is built/installed, the model is compiled and then added to the R
package.

R package: tests sbt

The sbht/tests directory contains a suite of tests that are run using the R package
testthat. These tests include comparing the values of likelihood components and
derived values from the TMB model and ensuring that they adequately match the
ADMB model (many of these tests are also illustrated in the Comparison with the
ADMB model vignette).

These tests will run when:

e The “Test” button in RStudio is pushed or using devtools: :test ()

e The “Check” button in RStudio is pushed or using devtools: :check ()

e A pushismadeto the GitHub repository (i.e., the tests are run automatically
using GitHub actions and an email is sent out if any tests fail)



R package: vignettes sbt

The sbht/vignettes directory contains all of the package vignettes which are
articles/pages that can include helpful information and examples. So far, the
vignettes for sbt include:

R package: logo

sbt - also called “Get started” on the website. This contains an example of how
to run asingle grid cell.

sbt_dev - a guide for model developers.

sbt_equations - not finished.

sbt_mcmc - Bayesian inference including an example of how to run an MCMC.
sbt_vs_admb - comparison between sbt and the ADMB model including a fixed
parameter run and a model fit.

The logo is generated using
sbt/man/figures/logo.R

The SBT picture was painted by
Joanne Webber (my mum)
specially for the sbt package

20



R package: website sbt

The website is stored in sbt/docs and is built using the R package pkgdown and can
be built locally using:

pkgdown: :build site()

If the website is built (as above) and then pushed to the repository, it will become
publicly available here:

https://quantifish.co.nz/sbt/

Alternatively, the website can be built automatically by GitHub using actions (i.e.,
continuous integration) and will update whenever a commit is pushed to GitHub.

R package: website sbt

Pages on the website include:

sbt - sbt/README.Rmd
Get started - sbt/vignettes/sbt.Rmd

Articles

o Model development - sbt/vignettes/sbt_dev.Rmd

o Model equations - sbt/vignettes/sbt_equations.Rmd

o Bayesianinference - sbt/vignettes/sbt_mcmc.Rmd

o Comparison with the ADMB model - sbt/vignettes/sbt_vs_admb.Rmd
e Reference

o  Helper functions

o Plots

o Data

e Changelog - sht/NEWS.md

21
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R package: website

Navigation -
tabs

Article title F sy
Article /

source

= a On this page
Bayesian inference
Introduction
Source: yigneties/sbt scec.fed sht .
: Loat fopuns Navigation

Introduction Model setup vials
Bayesian inference is done using tmbstan which makes use of Stans Marlov chain Mante Carlo Optimisation abs
(MCMC) algorithm, specifically the no U-turn sampler (NUTS). Markov chain Monte Carlo
Load inputs
Below the required R libraries are loaded.

Library(tigyverse) n

library(sbt)

Library( tsbstan) Code chunk

liorary|kableExtra)

library(bayesplot)

theme set(theme bw())

# Specify the numbar of cores for MCMC

options(mc.cores = parallel::gdetectCores())
Model setup
Example inputs that are loaded from the sbt package. Normally the user would import these
inputs (e.g. from .csv files using the read_csv functicn).

Define the data list. The get_data function sets up some additional inputs that are required

before the data list can be passed to MakoADFun . S

attachidata_csvl)

R package: continuous integration (Cl) sbt

GitHub actions is used to automatically runR CMD CHECK whenever a commit is
pushed to the GitHub repository:

Controlled using the .github/workflows/R-CMD-check.yaml file
Compiles the model / package on Linux, Mac, and Windows machines
Checks for errors in the code

Runs tests using the R package testthat

24



Installation sbt

Alist of different ways to install sbt can be found in the README document.
For this workshop it would be best if you could:

1. Install GitHub, RStudio, and Rtools (if on Windows)

2. Clonethesbtrepo:git clone https://github.com/quantifish/sbt

3. Clonetheworkingrepo:git clone
https://github.com/CCSBT-Dev/sbt models

Installation

1. Open RStudio

2. Recommend creating a project using New Project->Existing
Directory->Navigate to sbt->Create Project

3. Install sbt using: devtools: :install ("sbt") or
pushing the “Install” button

Znvironmer,* History Connections Build Git Tutorial

4+ 3 [ install - B Test g Check ¥ More ~
plot_loe. no visible binding for global variable ‘name’
plot_loo: no ble global function definition for ‘separate’
plot_loo: no visible binding for global variable ‘Variable’

25
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Interactive session
Helping with anything:

e installationissues
e compilerissues
e using GitHub

27
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Template model builder (TMB)

Template Model Builder (TMB) is an R package for fitting statistical latent variable
models to data. It is inspired by ADMB. Unlike most other R packages the model is
formulated in C++. This provides great flexibility, but requires some familiarity with
the C/C++ programming language.

A TMB project consists of an R file (*R) and a C++ file (*cpp). The R file does pre- and
post processing of data in addition to maximising the log-likelihood contained in

*

.Cpp.

The purpose of the C++ program is to evaluate the objective function, i.e. the
negative log-likelihood of the model. The program is compiled and called from R,
where it can be fed to a function minimizer like n1minb.

Where to find the sbt model/code

The sbt model/code can be found in the sbt repository under the source (src)
directory and consists of two files:

e sbt/src/sbt_v100.cpp
e sbt/src/functions.hpp



e get phi ® get length like
e get M ® get age like
® get rho ® get cpue like
® get recruitment ® get aerial survey like
® get selectivity ® get troll like
e get initial numbers ® get tag like
® get harvest rate e get POP like
e first difference ® get HSP like
¢ third difference ® get GT like
® norm?2 ® get sel like
® sguare ® get recruitment prior
5
Inputs Functions can on!y
_ return one container
3 - (e.g.,avectorora
matrix).
Variables declared ina
function are not
available globally.
A pointer is an address
n_age; da++) { to alocation in memory
‘ FLAFLEIEL = that can be passedto a
N(n_age - 1) /= Type(1.8) - exp(-M a(n_age ); function.
. . ‘ When avalue is
AT D (D (il £ ((Ty )5 = assigned to the pointer,
*RO * rel N; it saves the value to the

original location of the
defined variable. Thus,
we can return many
things from a function.
rs(par B@, par_h, &R@, &alpha, &beta, M a, phi va); 6




Type definitions for variables

Type RO, alpha, beta;

vector<Type> S_a(n_age);

array<vector<Type=> number_ysa(n_year +
array<vector<Type>> hrate_ysa(n_year +

vector<Type> urate_f(n_fishery);

array<vec Type>> catch_pred_fya(n_fishery, n_year
array<Type> catch_pred_ysf(n_year 1, n
vector<Type> spawning_biomass_y(n_year +

FUNCTION get_HSP_like( ix)
cl,c2,cmin,cmax,nC,nK,diffc;

dvariable cumS,xtmp;

ghsp = mfexp(lnghsp)

Zero indexing

L 0:
af_fishery(i)
y = af_year(i

n_af; i++)

amin = af_min_age(i);
amax = af_max_age(i);
n_a = amax - amin

, n_fishery);

nC, nK, cmin, cmax, cdif;

Type xtmp, cumS, pp;
gamx_ya(n_year, n_age)

matrix<Type>
vector<Type>
vector<Type=>
vector<Type>

FUNCTION
ii, iy;

get_indices_like(

dvector weights
1n_like(ix



If statements that depend on a parameter or quantity derived from a parameter are
NOT allowed.

Things you should NOT do in TMB

* Donotuse if(x) if x isa PARAMETER, or is derived from a parameter. TMB will remove the whole if-statement
and hence produce surprising results. As an alternative, you can use statements. However, this can easily
create a non-differentiable likelihood, so make su L v what you are doing (i.e., check the differentiably of
ahead of time). and
Do not attempt to weight the loglikelihood within the C++ code (See: ). This results in a non-normal latent
distribution, de: uracy of the Laplace approximation.

If statements that depend on a parameter or quantity derived from a parameter are
NOT allowed.

AD Conditional Expressions

Syntax
result = CondExpRel(left, right, if _true, if_false)

Purpose

Record, as part of an AD of Base operation sequence , the conditional result
fl left Cop right )

result = if_true

lse

result = if false

The relational Rel and comparison operator cop above have the following correspondence:
Gt

Rel Lt Le Eq Ge

Cop < <= == = =
If f is the ADFun object corresponding to the AD operation sequence, the assignment cholice for result in an AD conditional expression is made each time f,Forward is use
AD comparison operators which are boolean valued and not included in the AD operation sequence.
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If statements that depend on a parameter or quantity derived from a parameter are
NOT allowed.

* log(phsp_i(1)) + (nC - nK) * log(Type(1.0) - phsp_i(1i));

nC * log(Type(1.0 phsp_1i(1));

From the HSP likelihood
function.

Also in the POP likelihood

1p(i) = CppAD::CondExpGt(phsp_i(i), Type(0.0) and harvest rate

nK * log(phsp_i(1)) + (nC - nK) * log(Type(1.0) - phsp_i(1)) calculations (we should
. review the harvest rate

Type(0.0)); .
L function). 7

Random effects - for example, you could estimate sigmaR

obj <- MakeADFun(data = Data, parameters = Params, map = Map, random = Random,
hessian = , inner.control = list(maxit DLL = "sb




Comparisons between the TMB and ADMB models

See the Comparison with the ADMB model vignette - go to website.

Adding new code

See the Model development vignette - go to website.
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1. Open RStudio

2. Recommend creating a project using New Project->Existing
Directory->Navigate to sbt_models->Create Project

Open the file example_run.R

4. Step through this code - this will run a single grid cell!

w

3 sbt_models -

¥ More ~ 5. main- C-

opt <- nlminb(start = objSpar, objective = obj5fn, gradient = objsgr,
lower = bnd$lower, upper = bndSupper




Alternatively, see the Get started tab on the website which steps through a model
run.

sht model n this page

| - Lead inputs
Source sbt

Input es
Load inputs Input plots

red R libraries are loaded. The sbt TMB model i
g library(sbt).The kableExtra pac
its. The code theme_set(theme_bw()) alters the plot 2

e e

aded along Model setup

ctions us

kage

s used for generating

Optimisation

netics.
Plot outputs
(THE)
tidyverse)
sbt)
rary(kableExtra)

inputs that are lo.

sbt pa
read_csv function)

g, from .esv files .

attach(data_csvi)

(data_csvi)

a project using Mew Project->Existing
> tosht els->Create Project
example_run.R

ough this code - this will run a single grid cell!

1a mode|




Extracting outputs

See the Reference section of the website
under the heading Helper functions for a list of
functions, some of which can be used to
extract outputs.

Otherwise, take a look at the code that
produces the plots (next slide).

Generating figures and tables

See the Reference section of the website under the

heading Plots for a list of plots that can be produced.

1000

Aerial survey

a—— - Sy, -
. T v 7 - R
e o LT, .
. Team_ 20y -
- -
1935 2000 2005 2010 2015
Year

Helper functions
Build a data set or extract something.

get_array()
Convert a 2D array of vectors to an array

get_bounds()
Get default parameter bounds

get_data()
Set up the data input file

get_di(}
Obtain dl

get_grid(}
Set up a grid

get_length_at_age()
Obtain the length at age array

get_loo()
Obtain the leave-one-out information criterion (LOO IC)

get_map()
Get default parameter mapping

get_parameters()
Get default initial parameter values

get_posterior()
Obtain samples from the posterior distribution of reported q

get_sel_list()
Get list of selectivity parameters

Plots

Plot an input or output.

plot_aerial survey()
Plot aerial survey

plot_biomass_spawning()
Plot spawning biomass

plot_catch()
Plot catch

plot_cpue()
Plot CPUE

plot_hrate()
Plot harvest rate

plot_initial numbers()
Plot initial numbers

plot_length_at_age()
Plot length

plot_loo()
Plot PSIS LOO

plot_natural mortality()
Plot natural mortality
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Bayesian inference is a method of statistical inference in which Bayes' theorem is
used to update the probability for a hypothesis as more evidence or information
becomes available.

Markov chain Monte Carlo (MCMC) methods comprise a class of algorithms for
sampling from a probability distribution. By constructing a Markov chain that has
the desired distribution as its equilibrium distribution, one can obtain a sample of
the desired distribution by recording states from the chain.

Open RStudio

Open the file example_mcmc.R

Step through this code - this will run an MCMC for a single grid cell!
MCMC takes about 3 hours to complete (but don’t worry, | prepared one
earlier!)

A -

mcmcl <- tmbstan(obj = obj, lower = bnd$lower, upper = bndSupper,

init = rep(list(Params), 2), chains = 2,
control = list(max_treedepth = 12, adapt_delta = 0.9))
save(mcmcl, file = 1.rda

Load( "mcme




Extracting samples from  obtain samples from the posterior
the D osterior distribution of reported quantities (s

Source: R/get-posterior B

When samples from the posterior distribution are obtained using tabstan, only the model
parameters can be accessed directly from the stanfit object (i.e, derived quantities such as

Extracti ng sam p Ies from the posterior par_B8 or M_a cannot be accessed directly). Accessing derived quantities must be done using
; the this function.
can be done using the

; Usage
get_posterior function.

get_posterior(object, posterior, pars = "par_B8", option = 1)

Unfortunately, this function is very Arguments

SIOW and (Currently} Only eXtraCts one “ﬁisl specifying the AD object created using MakeADFun .

output at a time. posterior

An rstan objected created using the tmbstan function.

Profiling revealed that the slowest i

part of this function is the option _

object$report (par) call making it bk

difficult to speed up s

" A data.frame. 5

Plotting MCMC outputs

Function: plot_natural_mortality
. L e Posterior distribution

;“‘““h Frequentist optimum

0.4

B .

g Median of the

Qp3 u

5 posterior

5.2
0.1
80— 10 20 30

Age



Plotting MCMC outputs

Function: plot_cpue

/ Data
/ Posterior distribution

—— Median of the

\ posterior
Frequentist optimum
Posterior predictive

distribution

\

tA

CPUE

7 A

1970 1980 1990 2000 2010 2020
Year



MCMC diagnostics

There should be no divergent transitions

The effective sample size of all parameters should be at least 400
The Rhat statistic for all parameters should be less than 1.01
MCMC trace plots should look good

Should check for parameters up against bounds

MCMC diagnostics: Rhat

par_sels_change_i[6]
par_sels_change_|[5]
par_sels_change_i[7]
par_logit_hstar_i[1]
par_rdev_y[39]
par_sels_init_i[14]
par_sels_Inkt_I[15]
par_sels_change_i[4]
par_sels_change_i[8]
par_sels_change_i[9]
par_sels_change_i[56]

par_sels_init_i[16] R<1.05
par_rdev_y[46] =

par_sels_change_i[10] = Rsaa
par_rdev_y[38] . - f-.1.1

par_sels_init_i[72]
par_sels_Init_i[13]
par_sels_change_i[57]
par_sels_change_i[440]
par_sels_init_I[73]
par_sels_change_i[533]
par_rdev_y[53]
par_rdev_y[44]
par_rdev_y[37]
par_sels_Inkt_I[33]
par_sels_change_i[285]

1.00 1.05



MCMC diagnostics: effective sample size

Parameter Mean 25%  Median 97.5% Eff. N
lp__ -6383.375 -6436.974 -6383.432 -6332.278  693.891
par_log_BO 15.981 15.651 15.982 16.311  520.853
par_log_mo -0.819 -1.004 -0.816 -0.663 2097.951
par_log_mé 1889 2030  -1.886  -1755 1089.033
par_log_m10 2410 -2.803 -2.398 2100 670913
par_log_m30 -0.825 -1.038 -0.826 -0.617  1937.215
par_log_cpue_q 0017  -0.075 -0.016 D.040 2839957
par_logit_hstar_i[1] -4,318 -B184 3.948 3176 278747
par_logit_hstar_i[2] -4,663 -9.265 -4.004 -2.640 802172

MCMC diagnostics:
trace plots

Signs of poor mixing for BO (also
has relatively low effective sample
size rate), m10, and possibly m4.
These issues are all easily fixed
with more iterations, longer warm
up, tweaking MCMC settings,
and/or thinning.

hstar[1] is having a very hard time
(it has the worst effective sample
size rate, see previous slide).

6300
6350
6400
6450

Rhat
1.001
1.003
1.001
1.001
1.001

1.000

1.007

par_sels_init_i[36]
par_sels_init_i[72]
par_rdev_y[43]
par_sels_init_i[&4]
par_rdev_y[39]
par_sels_init_i[59]
par_sels_init_i[54]
par_sels_init_i[63]
par_sels_init_i[38]
par_sels_init_i[60]
par_sels_init_i[37]
par_sels_init_i[62]
par_sels_init_i[61]
par_sels_init_i[48]
par_rdev_y[38]
par_sels_init_i[53]
par_sels_init_i{49]
par_sels_init_i[52]
par_sels_init_i[50]
par_sels_init_i[51]
par_sels_init_i[33]
par_logit_hstar_I[1]
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MCMC diagnostics: pairs and

parallel coordinates plots "’? ’ 1- I
Y ER-AFK-NSE ’3

Divergent transitions shown inred.

100300 05 -12.510.0

Reduced Bayesian grid structure

e Runagrid using the run_grid function (108 runs)
m0 ={0.4,0.45, 0.5}
m10 = {0.065,0.085, 0.105}
o h={0.55,0.63,0.72,0.8}
psi={1.5,1.75, 2}
e Proposetorunareduced grid of MCMCs (12 MCMCs). No function to do this
yet. Could reduce this grid even further?
o EstimatemO
o Estimatem10
o h={0.55,0.63,0.72,0.8}
o psi={1.5,175,2]}

osd 54 054
oo 0 Y
10—t 104—— & ] qoi I

[ 1z 3 6 3 3 0-0.5 0.0 0.5 1 1

" r ) T | par_lagit_hstar_i{1]
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41 5 | 5q
8 = ] o ' i1
e Fma— X i g eon e 8
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Comparison of grid and MCMC uncertainty

104

Spawning biomass (millions of tonnes)

Model comparison

The leave-one-out information criterion (LOO IC) can be used for model diagnosis (e.g.,

1940 1960 1980
Year

2000

identifying specific problematic data points), model selection, and model averaging.

if (FALSE) {
lool <- get loo(data = Data, object = obj, posterior = mcmcl)
save(lool, file = "lool.rda")

} else {
load("lool.rda")

print(leo1)

H

#> Computed from 2080 by 4118 log-likelihood matrix
=

#> Estimate SE

#> elpd_loo 5562.6 767.6

#> p_loo 135.2 16.8

#> looic -11125.2 1535.1

8> =ccean

#> Monte Carlo SE of elpd_loo is NaN.
H=

#> ALl Pareto k estimates are good (k < 8.5).
#> See help('pareto-k-diagnostic') for details.

Pareto shape k

-20

PSIS diagnostic plot

aq

Variable
o aerial
& af

cpue

x gt

o hsp

.



Model averaging or stacking can also be done using the LOO package. First the
model weights can be extracted using the 1oo model weights function. Then
samples from each model can be extracted from each of the models according to
their model weights (or something along these lines).

Method: pseudo-BMA+ with Bayesian bootstrap

modell 0.362
model2 0.131
model3 0.246
modeld 0.261
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Outstanding issues

All outstanding issues can be found here:

https://github.com/quantifish/sbt/issues

Model changes

Environment

Population model and likelihood ideas for next

CCSBT OM

R. Hillary & J.P. Eveson




Model changes

e Change to age-length model (big job)
e Selectivity
e Whatelse?



Projections code

Nothing done yet. Can be done using simulation block in TMB. For example:

SIMULATE {
y = rnorm(mu, sd); // Simulate response
REPORT (y); // Report the simulation

}

And this can be run using:
objS$simulate ()

https://kaskr.github.io/adcomp/Simulation.html

Tackling some issues

e Check age likelihood again (small difference in likelihood)Apply maximum
harvestrateinget harvest rate function

e Revisetheget tag like functionand output likelihood for each data point
so that the LOO IC can be calculated

e What should we do with the get posterior function? It is slow. Could output
posterior for all quantities in REPORT, which would be even slower, but would
only need to be done once.
What should we do with selectivity?
Review all priors and make them all proper.
Review all likelihoods and change to R style likelihoods where applicable.



Implementing some model changes

e Change to age-length model (big job)
e Selectivity
o Whatelse?
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